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Introduction
The PanaView™ graphical user interface offers interactive 
communications between Windows-based PCs and the GE 
Panametrics PT878 portable flowmeter. (Compatible 32-bit 
Windows operating systems include Windows 98SE, NT 4.0 
(with Service Pack 6), 2000, XP and ME). With PanaView, you 
can:

• set meter parameters to control the instrument

• create and save graph and log files

• display text output and graphs of live measurement data

• create custom templates for displaying text, graph and log data

• interface with multiple GE Panametrics instruments.

This document focuses on particular applications of PanaView 
for the PT878 flowmeter. For general PanaView applications such 
as creating graph and log files, displaying live measurement data, 
and creating custom templates, please refer to the general 
PanaView User’s Manual (910-211).
PanaView for the PT878 1
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Connecting the IR232 Interface
On the PT878, an internal infrared transceiver enables 
communication between the meter and IR ports or dongles (IR to 
RS232 adapters) of Windows®-based PCs.  However, the typical 
desktop PC setup does not offer a built-in IR port. Therefore, to 
establish IR communications, you must connect the RS232 
adapter of an IR dongle (such as the Actisys 220L+ shown in 
Figure 1a below) to an available COM port on the PC (Figure 
1b).

Figure 1:  IR Dongle (a) Connected to RS232 Port (b)

Note: The PT878 was designed for use with products that 
comply to the IrDA protocol. For more information on 
establishing IR communications between the PT878 and 
your PC, refer to Appendix F of the PT878 User’s Manual.

(a) (b)
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Establishing Communications with 
PanaView
After you have connected the IR dongle to a communications port 
of your PC, the procedure for establishing communications with a 
meter may be started. Be sure that the IR beam on the PT878 has 
clear access to the IR sensor face on the dongle connected to the 
PC port.

Setting Up the Communications Port
Use the steps below to establish communications with a PT878 
flowmeter.

1. Open the “New Meter Browser” window and expand the 
network tree. Then, highlight the My Computer (Name) 
branch by clicking on it.

2. Pull down the “Edit” menu by clicking on it in the menu bar.

3. Click on the “New” menu option to select it, and a submenu 
opens with two choices on it (see Figure 2 below).

Figure 2:  The Edit Menu
PanaView for the PT878 3
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Setting Up the Communications Port (cont.)
4. Click on the “Communications Port” option to select it. The 

Setup Communications screen appears similar to Figure 3 
below.

Figure 3:  Setup Communications Screen 

5. Open the Protocol menu (the first of the drop-down menus) 
and click on PanaLink. 

6. Select the communications port (COM1 or COM2) from the 
drop-down menu.

7. In the Name text box, enter a name for the communications 
port.
4 PanaView for the PT878
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Setting Up the Communications Port (cont.)
8. For the Com Port type, select either IrDA or IR232. 

IMPORTANT: IR232 generally provides better performance 
than IrDA. If you select IR232, you must disable 
the drivers in the infrared device connected to 
your PC for the device to work with PanaView. 
From the Control Panel, click on the System 
icon, and then on the Hardware tab. Click on 
Device Manager, and then on the specific 
infrared device listed under Infrared Devices. 
Finally, click on Disable to disable the device 
drivers. 

9. You now have two options:

• If you have selected IrDA, you have finished entering 
parameters in this window. 

• If you have selected IR232, select the following settings for 
the remaining parameters:

• Baud Rate — 19,200

• Parity — None

• Data Bits — 8 

• Stop Bits — 1

IMPORTANT: Be sure all the communications port settings 
match those in the meter’s Communications 
option. 

10.Click on [OK] to complete data entry.
PanaView for the PT878 5
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Adding the PT878
To add a PT878 meter on the IR232-configured communications 
port, complete the following steps: 

1. Highlight the communication port to which the meter will be 
added by clicking on it, and then open the “Edit” menu on the 
menu bar (if the communication port is not highlighted first, 
the “New Meter” option is not active in the “Edit” menu).

2. Click on the “New” option in the “Edit” menu (see Figure 4 
below).

Figure 4:  "New" Option in the "Edit" Menu

3. After clicking on the “New” option, the “Meter” menu option 
appears. Click on this option to select it.

4. After selecting the “New” and “Meter” options, the dialog 
box shown in Figure 5 on the next page appears. Select the “I 
don’t know the node ID of the meter I am adding to the 
network” radio button and then click on the [OK] option 
button.

Note: When installing the first meter on the network, even if you 
know the node ID assigned to the meter, it is more 
foolproof to allow PanaView to retrieve the information 
directly from the meter. If the “I know the node ID of the 
meter I am adding to the network.” option is selected 
instead, the process skips directly to Step 8 on page 9.
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Adding the PT878 (cont.)

Figure 5:  The Node ID Dialog Box

5. After responding to the previous dialog box, the dialog box 
shown in Figure 6 below appears. In this instance, the PT878 
communicates via an IR232 dongle connected to the comport. 
Therefore, select the “It is the only meter connected to the 
communication port” radio button and then click on the [OK] 
option button.

Figure 6:  The Only Meter Dialog Box
PanaView for the PT878 7
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Adding the PT878 (cont.)
6. After responding to the previous dialog box, a dialog box 

showing the Node ID (16 in this example) of the meter 
appears (see Figure 7 below). Select the “I wish to use this 
Node ID” radio button and then click on the [OK] option 
button.

Note: PanaView gets this Node ID directly from the meter; do 
not use a different Node ID for a single-meter setup.

Figure 7:  Node ID Confirmation

Figure 8:  Confirmation Dialog Box
8 PanaView for the PT878
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Adding the PT878 (cont.)
7. At the dialog box shown in Figure 8 on the previous page, 

click on the [OK] option button to add the meter and configure 
it. The dialog box shown in Figure 9 below appears.

Figure 9:  The Add Meter Dialog Box

8. In the dialog box above, enter a name for the new meter. The 
Node ID and Meter Communication Parameters have been 
entered automatically by PanaView. In addition, PanaView 
populates certain other fields, such as “Model Name,” 
“Firmware Version,” and “PCI Order Number” with data 
retrieved from the GE Panametrics instrument. Click on the 
[OK] option button to initialize the new meter.
PanaView for the PT878 9
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Adding the PT878 (cont.)
After completing this step, do not make any inputs with either the 
mouse or the keyboard until the new meter initialization process 
is completed. While the meter is initializing, the information 
shown in Figure 10 below is added to the new meter dialog box.

Figure 10:  The Initialization Screen

Note: The “Clock” text box has been filled in with the current 
date and time, the name “PT878” has been added, and 
the active communications status is being displayed along 
the bottom of the dialog box.

After the initialization has been completed, PanaView adds the 
new meter to the PanaView network tree and automatically closes 
the “Add New Meter” dialog box.
10 PanaView for the PT878
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Programming a PT878 with PanaView
PanaView enables you to remotely change the programming of 
your PT878 flowmeter. You can perform a variety of operations:

• Set up the initial transducer and pipe parameters,

• Program the Energy Option,

• Set up inputs and outputs, 

• Add, change or delete user equations and user tables, 

• Program certain service parameters,

• Check the battery and backlight,

• Display meter measurements on your PC, 

• Vary modes and display units.

For a complete explanation of PanaView’s capabilities, see the 
PanaView User’s Manual (910-211). 

Setting Up Initial Parameters
Through PanaView, you can remotely program essential data for 
a given PT878 site — the transducer, pipe, lining (for clamp-on 
transducers), fluid and path parameters. (These parameters are 
discussed in Chapter 3, Programming Site Data, of the PT878 
User’s Manual.) 

To program initial setup data:

1. From the “File” menu, click on the “New Meter Browser” 
option.

2. From the network tree, click on the desired communications 
port (COM 1, etc.) and meter.

3. From the expanded tree, click on the “Channel 1” option. The 
listing appears similar to Figure 11 on the next page. 
PanaView for the PT878 11
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Setting Up Initial Parameters (cont.)

Figure 11:  Meter Menu for PT878

4. To enter basic setup parameters, click on the “Program” 
option. The PT Setup window opens, as shown in Figure 12 on 
the next page.
12 PanaView for the PT878
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Setting Up Initial Parameters (cont.)

Figure 12:  The PT Setup Window

Note: The choices made in the Transducer and Pipe options 
determine the later programming options. If a tab or 
parameter has been “grayed out,” it is either 
preprogrammed by an earlier choice or not necessary for 
that transducer or pipe type. For example, the Lining form 
is not available for wetted transducers.
PanaView for the PT878 13
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Transducer Setup
The first option in the PT Setup window allows you to set up 
parameters for the transducers you have installed. Refer to the 
Liquid Transducer Installation Guide (916-055) for additional 
information about transducers and configurations.

1. The first prompt asks you to select the type of transducer, 
either wetted or clamp-on. Click on the desired radio button.

2. The list at the left of the window now lists the available 
preprogrammed or special transducers for your transducer 
type. Click on the desired transducer number, or on SPECIAL 
if your transducer is not listed.

If you have selected a transducer on the list, the PT878 supplies 
PanaView with the needed parameters. Click on another tab to 
continue programming. However, if you have selected SPECIAL, 
continue as shown below.

Special Transducers
The window appears similar to Figure 13 below.

Figure 13:  The Transducer Form for a Special 
Transducer
14 PanaView for the PT878
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Special Transducers (cont.)
3. PanaView asks for the transducer frequency. Open the drop-

down list of five frequencies, and click on the desired 
frequency.

4. The next prompt requires the time delay (the time the signal 
takes to travel through the transducer and cable). Click in the 
Time Delay text box, and enter the GE Panametrics-supplied 
time delay.

5. PanaView now asks for the wedge angle (the angle of the 
ultrasonic transmission). Click in the Wedge Angle box, and 
enter the GE Panametrics-supplied wedge angle.

6. The next prompt asks for the wedge temperature. Click in the 
Wedge Temperature box, and enter the temperature.

7. The final prompt asks for the wedge sound speed. Click in the 
Wedge Sound Speed text box, and enter the GE Panametrics-
supplied sound speed.

You have completed entering data in this option. Click on another 
tab to continue programming.
PanaView for the PT878 15
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Pipe Setup
The Pipe option appears similar to Figure 14 below.

Figure 14:  The Pipe Option

1. The first prompt asks for the pipe material. From the list in the 
left window of the option, scroll to the appropriate material 
and click on it, or on “Other” if your material is not listed.

a. If you select “Other,” you must enter the sound speed. 
Click in the sound speed text box, and enter the desired 
sound speed.
16 PanaView for the PT878
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Pipe Setup (cont.)
2. PanaView now asks for the pipe outside diameter. Click in the 

Outside Diameter text box to enter the diameter, and in the 
Wall Thickness text box to enter the wall thickness.

or
If you select certain materials (carbon or stainless steel, cast 
iron, PVC and CPVC), you can use the DIN pipe standard to 
enter the pipe dimensions. 

a. Click in the check box to obtain the DIN pipe standard.

b. At the Nominal option, pull down the drop-down menu 
and click on the desired pipe size.

c. At the Schedule option, pull down the drop-down menu 
and click on the desired schedule.

3. You have finished entering data in this option. Click on 
another tab to continue programming, or click on [Apply] to 
immediately apply the changes, and on [OK] to confirm the 
changes and close the window. (To return the window to its 
previous settings, click on the [Cancel] button.)
PanaView for the PT878 17
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Fluid Setup
The Fluid window appears similar to Figure 15 below.

Figure 15:  The Fluid Option

1. The first prompt asks if you want to use tracking windows, 
which detect the receive signal when you are unsure of the 
fluid sound speed. Click on the box if you wish to use tracking 
windows.

2. You must next select the desired fluid. From the list in the left 
window of the option, scroll to the desired fluid and click on 
it.

For all selections except “Other,” PanaView supplies the sound 
speed, along with minimum and maximum values. You have 
completed entering data in this option. But if you selected 
“Other” and “Tracking Windows,” continue to step 3.
3. For the sound speed value, minimum and maximum sound 

speeds, and glycol percentage (if available), click in the 
appropriate text box and enter the desired values.

4. You have finished entering data in this option. Click on 
another tab to continue programming, or click on [Apply] to 
immediately apply the changes, and on [OK] to confirm the 
changes and close the window. (To return the window to its 
previous settings, click on the [Cancel] button.)
18 PanaView for the PT878
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Lining Setup
Note: This option is only available if you have selected a clamp-

on transducer in the Transducer option.

The Lining option appears similar to Figure 16 below.

Figure 16:  The Lining Option

1. PanaView asks you to select the lining material. From the list 
in the window at the left, click on the desired lining.

a. For all options except “Other,” PanaView supplies the 
lining sound speed. But if you have selected “Other,” click 
in the Sound Speed text box and enter the desired sound 
speed.

2. You must now enter the material thickness. Click in the 
Thickness text box and enter the desired thickness.

3. You have finished entering data in this option. Click on 
another tab to continue programming, or click on [Apply] to 
immediately apply the changes, and on [OK] to confirm the 
changes and close the window. (To return the window to its 
previous settings, click on the [Cancel] button.)
PanaView for the PT878 19
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Path Setup
The Path option appears similar to Figure 17 below.

Figure 17:  The Path Option

1. If you are using wetted transducers, you must enter the Path 
Length and Axial Length. For each value, click in the text box 
and enter the GE Panametrics-supplied value.

2. If you are using clamp-on transducers, the PT878 enters the 
transducer spacing; however, you can use the text box to 
override the spacing. You can also enter the number of 
traverses (times the ultrasonic signal crosses the pipe).  For 
each value, click in the text box and enter the appropriate 
value.

3. You have finished entering data in this option. Click on 
another tab to continue programming, or click on [Apply] to 
immediately apply the changes, and on [OK] to confirm the 
changes and close the window. (To return the window to its 
previous settings, click on the [Cancel] button.)
20 PanaView for the PT878
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Rebuilding the Database
If you have a problem opening the setup window, you might wish 
to rebuild the PT878 database. Click on the [Rebuild DB] button 
at the far left of the PT Setup window, as shown in Figure 17 on 
the previous page. The text boxes gray out, and the window 
appears similar to Figure 18 below.

Figure 18:  The PT Setup Window, as PanaView 
Rebuilds the Database

Rebuilding the database will take a few minutes. Please wait 
while PanaView rebuilds the database. When PanaView has 
finished, click on another tab to continue programming, or click 
on [OK] to confirm the changes and close the window. 
PanaView for the PT878 21



July 2003
Viewing Signals
To view the raw signal received by the current PT878 setup, click 
on the [Signals] button at the left of the PT Setup window. The 
Signal Graph window opens, as shown in Figure 19 below.

Figure 19:  The Signal Graph Window

1. From the drop-down menu at the lower left of the window, 
you can choose from five signal types: Raw Up or Down, 
Correlation Up or Down, and Cross-Correlation (XCorr). Pull 
down the menu and click on the desired signal.

2. To select the signal group, click on the radio button for group 
1 or 2.

3. If you wish to show the graph points, click on the Show Points 
box.

4. You can now choose from three options:

• Click on [Clear] to clear any previous graph from the 
window.

• Click on [Plot] to plot the signal as a graph. The graph 
appears similar to Figure 20 on the next page.

• Click on [Close] to close the window and return to the PT 
Setup menu.
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Viewing Signals (cont.)

Figure 20:  A Cross-Correlation Signal Graph
PanaView for the PT878 23
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Setting Up the Energy Option
To set up energy measurement parameters, click on the “Energy” 
option shown in Figure 11 on page 12. The window appears 
similar to Figure 21 below.

Figure 21:  The Energy Option Window

1. The first prompt asks if you wish to enable or disable the 
Energy Option. Click on the appropriate radio button to enable 
or disable the option.

Note: If you click on “Disabled,” you will not be able to enter 
any other parameters in this option.

2. The next prompt asks if you are measuring a heating or 
cooling system. Click on the desired button.

3. The final prompt asks if you are measuring flow at the point of 
supply or return. Click on the appropriate button.
24 PanaView for the PT878
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Setting Up Inputs in the Energy Option
To set up inputs for the Energy Option, click on the “Inputs” tab 
at the top of the window. The screen now appears similar to 
Figure 22 below. 

Figure 22:  Inputs in the Energy Option

1. The first prompt asks you to select a fixed or active input for 
the supply temperature. Click on the desired radio button. 

2. The next prompt varies with your choice in step 1.

• If you selected “Fixed,” the program asks for a specific 
temperature. Enter the desired temperature in the text box.

• If you selected “Active,” the program asks you to select the 
input. From the drop-down menu, click on “A” or “B.”
PanaView for the PT878 25
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Setting Up the Energy Option (cont.)
You have finished entering data in the Energy Option. Click on 
[Apply] to immediately apply the changes, and on [OK] to 
confirm the changes and close the window. (To return the window 
to its previous settings, click on the [Cancel] button.)
26 PanaView for the PT878
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Setting Up Inputs and Outputs
To set up the PT878 input and output parameters, click on the 
“Meter I/O” option shown in Figure 11 on page 12. The tree 
expands to show three options, “Analog Output,” “Analog 
Input,” and “Digital Output.” These options correspond to the 
options in the PT878 Program menu, and are described in Chapter 
3, Programming Site Data, of the PT878 User’s Manual. To 
access a particular option, double-click on the listing in the menu 
tree.

Note: Unlike other options, the input and output options accept 
and display values only in the unit type (English or 
metric) selected in the PT878. 

Setting Up the Analog Output
The window appears similar to Figure 23 below.

Figure 23:  Analog Output Window in the 
Meter I/O Menu
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Setting Up the Analog Output (cont.)
1. You must first select the output function. From the drop-down 

menu, click on one of three choices: Off, 0-20 mA or 4-20 
mA.

2. The program next asks for a data source. Click on the “Select 
Data Source” window, and a second window opens listing the 
available parameters and units. Click on the desired units.

3. You must next enter the zero value. Type the desired value in 
the text box.

4. You must next enter the span value. Type the desired value in 
the text box.

5. The last prompt, On Error, asks you to select how the PT878 
will handle the analog outputs in the event of a fault condition. 
You can choose from three alternatives:

• Hold Last Value (hold the last good reading)

• Force Low (force the reading to 0 or 4 mA)

• Force High (force the reading to 20 mA).

From the drop-down menu, click on the desired alternative.

You have finished entering Analog Output data. Click on [Apply] 
to immediately apply the changes, and on [OK] to confirm the 
changes and close the window. (To return the window to its previ-
ous settings, click on the [Cancel] button.)
28 PanaView for the PT878
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Setting Up the Analog Inputs
The window appears similar to Figure 24 below.

Figure 24:  The Analog Input Window
1. The first prompt asks for an input function. From the drop-

down menu, click on either “Off” or “General Purpose.”

Note: If you select “Off,” you will not be able to access any 
other parameters in this window. Also, if you have 
enabled the Energy Option (page 24), the function will be 
either “Supply Temp” or “Return Temp.”

2. The following prompts ask for an input label and input units. 
Enter the desired label and units in the appropriate text boxes.

Note: If you have enabled the Energy Option, the Label and Unit 
boxes are not available.

3. The remaining prompts ask for the zero and span values. Enter 
the desired values in the appropriate text boxes.

You have finished entering Analog Input data. Click on [Apply] 
to immediately apply the changes, and on [OK] to confirm the 
changes and close the window. (To return the window to its 
previous settings, click on the [Cancel] button.)
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Setting Up the Digital Output
The window appears similar to Figure 25 below. 

Figure 25:  The Digital Output Window, with the Pulse 
Totalizer Function Selected

1. The first prompt asks you to select a function type. From the 
drop-down menu at the upper right of the window, click on 
one of five choices:

• Off

• Pulse Totalizer

• Frequency

• Test Points

• Gate Input

The functions and their associated parameters correspond to those 
available in the Digital Output option of the PT878 Program 
Menu.

Note: If you select “Off,” you will not be able to access any 
other parameters in this function.
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Setting Up the Digital Output (cont.)
2. The next prompt asks you to select a data source. Click on the 

“Get Data Source” button. A second window opens, with a 
meter tree of available parameters and units. Click on the 
desired unit.

3. The parameters now vary with the selected function.

• If you selected Pulse Totalizer:

The prompt asks for the units/pulse, the pulse width (in 
microseconds), and the polarity.  

a. For Units/Pulse, click in the text box, and use the numeric 
keys to enter the desired value.

b. For Pulse Width, open the drop-down menu and click in 
the desired width in microseconds: 10, 20, 40 or 80.

c. For Polarity, open the drop-down menu and scroll to the 
desired polarity, either Low to High or High to Low.

• If you selected Frequency:

The program asks for the minimum and maximum frequencies 
and the duty cycle percentage. For each parameter, click in the 
text box, and use the numeric keys to enter the desired value.

• If you entered Test Points:

The prompt asks for the signal type from two choices, transmit 
and receive. Open the drop-down menu, and click on the desired 
signal.

• If you entered Gate Input:

a. The first prompt asks for the gate active. From the drop-
down menu, click on the desired gate active, whether 
Contact Open or Contact Closed.

b. The second prompt asks for the mode. From the drop-
down menu, Click on the desired mode, either Automatic 
or Manual.
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Setting Up the Digital Output (cont.)
You have completed entering parameters in the Digital Output 
option. Click on [Apply] to immediately apply the changes, and 
on [OK] to confirm the changes and close the window. (To return 
the window to its previous settings, click on the [Cancel] button.)
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Programming User Functions
As explained in the PT878 User’s Manual, user functions enable 
operators to program mathematical equations on each 
measurement, or to use any measured parameter to calculate a 
different parameter. PanaView allows users to program or change 
user functions and related tables through the PC.

To program a user function:

1. From the “New Meter Browser” option, click on the desired 
communications port, meter, and channel. 

2. Click on “User Functions,” and then double-click on the 
desired function (1 to 4). The right side of the screen appears 
similar to Figure 26 below. 

Figure 26:  The User Function Window
PanaView for the PT878 33



July 2003
Programming User Functions (cont.)
3. Enter three parameters:

• a function label (of no more than 16 characters)

• a function symbol (no more than 4 characters), and

• the number of decimal places desired.

4. To incorporate an existing parameter, pull down the network 
menu and click on the desired channel, measurement and 
display unit.

5. To select the desired operation or table, click on the 
appropriate button. (See Entering User Tables on the next 
page for information on entering data for user tables.) Use the 
cursor in the equation box to position values correctly, or to 
erase incorrect values or operations. 

6. To enter numeric values, use the numeric keys on your PC 
keyboard.

7. When you have completed entering the function, click on 
[Apply] to apply the function immediately, and on [OK] to 
confirm the function and close the window. To return the 
window to its previous settings, click on the [Cancel] button.

Note: It may be advisable to use the [Apply] button as a means 
of checking the function’s validity. If the function is 
improperly typed, or if a sensor is under range or not 
programmed, the Equation line displays “Invalid” with a 
brief message.
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Entering User Tables
To support user functions, the PT878 flowmeter can hold up to 
five tables (designated as A through E) of non-linear or empirical 
data. Users can enter up to 16 X-Y pairs in each table. A user 
function can supply an X value with Tbl(). The meter then 
interpolates the Y value for a given X, and substitutes it for Tbl 
(X) in the function. (See the section Setting Up User Tables in the 
PT878 User’s Manual.) 

To enter values for a user table:

1. From the “New Meter Browser” option, click on the desired 
communications port and meter.

2. Click on “User Tables,” and then double-click on the desired 
table.The right side of the screen appears similar to Figure 27 
below.

Figure 27:  User Table Window
3. Enter a name (up to 13 characters) for the table in the “Table 

Name” text box, and enter up to 16 X and Y values in the 
appropriate columns.The table now appears similar to Figure 
28 on the next page.
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Entering User Tables (cont.)

Figure 28:  Completed User Table

When you have finished entering values, click on [Apply] to 
apply the table immediately, and on [OK] to confirm the table and 
close the window. To return the window to its previous settings, 
click on the [Cancel] button.
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Entering Correction Factors
The Correction Factors option allows you to enter and modify 
three correction factors: Reynolds Correction, Kinematic 
Viscosity and Calibration Factor. To enter the Correction Factors 
option, double-click on the Correction Factors entry in the Meter 
menu shown in Figure 11 on page 12. The screen appears similar 
to Figure 29 below. 

Figure 29:  The Reynolds Correction Tab in the 
Correction Factors Window

1. The first prompt asks if you want to enable the Reynolds 
Correction factor, a number based on the Kinematic Viscosity 
and flow rate of the fluid. Click on the desired radio button.

Note: If you have enabled Tracking Windows, you must enable 
Reynolds Correction. Also, if you disable Reynolds 
Correction, you will be unable to enter any other 
parameters in this window.

2. The last prompt asks you to enter a Kinematic Viscosity 
number. Enter the number in the text box.
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Entering the Calibration Factor
To open the Calibration Factor window, click on the “Calibration 
Factor” tab on the right of the Correction Factors window. The 
screen now appears similar to Figure 30 below.

Figure 30:  The Calibration Factor Tab 
in the Correction Factors Window

1. The first prompt asks you to turn calibration correction on or 
off. Click on the desired radio button.

Note: If you turn calibration correction off, you will not be able 
to access any other parameters in this window.

2. The next prompt asks you to select a single K Factor or a table 
of K Factors. Click on the desired radio button.

3. The program varies, depending on your selection in step 2.

• If you select “Single,” enter a single value in the Meter K-
Factor text box.
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Entering the Calibration Factor (cont.)

• If you select “Table,” the program asks you to complete the 
table.

a. The first step is to select a data source. Click on the “Select 
Data Source” button. A second window opens, showing a 
PT878 tree with available parameters and units. Click on 
the desired unit.

b. The remaining step is to enter values in the table. Click on 
the “Edit Table” button. Another window opens with the 
table. Enter or change the desired X and Y values.

You have completed entering parameters in the Correction 
Factors option. Click on [Apply] to immediately apply the 
changes, and on [OK] to confirm the changes and close the 
window. (To return the window to its previous settings, click on 
the [Cancel] button.)
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Entering Service Parameters
In the Service option, you can set up parameters that affect the 
transducer signal: 

• Delta-T Offset

• Transmit Sample Size

• Zero Cutoff

• Velocity Averaging 

• Errors Allowed

• Error Limits

• Peak Detection Method

• Peak Thresholds

For an explanation of these parameters, refer to Chapter 8, 
Servicing the PT878, of the PT878 User’s Manual. To access the 
Service option, click on the desired meter and channel in the New 
Meter Browser. Expand the Service branch as shown below in 
Figure 31, and double-click on the desired option.

Figure 31:  The Service Option in the New Meter 
Browser
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Entering Signal Setup Parameters
The window appears similar to Figure 32 below.

Figure 32:  The Signal Parameter Window

1. The first prompt asks for the Delta T offset. Enter the desired 
value (in microseconds) in the text box.

2. Next, the program asks for the transmit sample size. Open the 
drop-down menu and click on the desired number.

3. The next prompt asks for the zero cutoff. Near “zero” flow, the 
PT878 may have fluctuating readings due to small offsets 
(caused by factors such as thermal drift in the fluid). The zero 
cutoff causes velocity measurements less than the cutoff to be 
reported as zero. Enter the value for the zero cutoff (in 
milliseconds) in the text box.

4. To select the velocity averaging value, open the drop-down 
menu and click on the desired number of velocity 
measurements to average.

5. The final prompt asks for the number of errors allowed before 
an error message appears. Enter the desired number in the text 
box.

You have completed entering signal parameters. Click on [Apply] 
to immediately apply the changes, and on [OK] to confirm the 
changes and close the window. (To return the window to its 
previous settings, click on the [Cancel] button.)
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Entering Error Limits
The Error Limits window appears similar to Figure 33 below.

Figure 33:  The Signal Error Limits Window

1. The first prompt asks for the minimum and maximum limits 
for the transducer signal received by the PT878. The E1: LOW 
SIGNAL error message appears if the signal strength falls 
below the limit programmed here. Enter the desired values in 
the text boxes.

2. Next, the program asks for the low and high velocity limits. 
The E3: VELOCITY RANGE error message appears if the 
velocity falls outside these limits. Enter the desired values in 
the text boxes.

3. You must now set low and high limits for the amplitude 
discriminator. The discriminator measures the size of the 
transducer signal sent from the PT878. If the signal falls 
outside these limits, the E5: AMPLITUDE ERROR message 
appears. Enter the desired values in the text boxes.
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Entering Error Limits (cont.)
4. The program now asks for the acceptable limit for the sound 

speed. If the fluid sound speed exceeds that entered in the Pipe 
option of the Program menu by more than this percentage, the 
E2: SOUND SPEED ERROR message appears. Enter the 
desired percentage in the text boxes.

5. The final prompt asks for the acceleration limit for detecting 
cycle skipping. The E6: ACCELERATION ERROR message 
appears if the velocity changes by more than this limit from 
one reading to the next. Enter the desired limit in the text box.

You have completed entering error limits. Click on [Apply] to 
immediately apply the changes, and on [OK] to confirm the 
changes and close the window. (To return the window to its 
previous settings, click on the [Cancel] button.)
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Entering Peak Detection
The Peak Detection window appears similar to Figure 34 below.

Figure 34:  The Peak Detection Window

1. The first prompt asks you to select the Peak Detection method. 
In the “Peak” method, the peak is identified by testing a 
derivative of the signal. In the “Threshold” method, the peak 
is identified as the point where the signal crosses a threshold 
that is a percentage of the maximum signal detected. The peak 
method is more reliable in identifying the signal in dynamic 
conditions, while the threshold method is more reliable in 
marginal signal conditions.
Click on the radio button for the desired method.

Note: Do not change the peak detection method or values unless 
recommended by GE Panametrics.

2. If you select “Peak,” you have completed entering data in this 
option. But if you select “Threshold,” you must also enter the 
minimum and maximum threshold percentage (available from 
0 to 100) used to measure transit time, as well as the 
percentage of peak. Enter the desired values in the appropriate 
text boxes.
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Entering Peak Detection (cont.)
You have completed entering peak detection data. Click on 
[Apply] to immediately apply the changes, and on [OK] to 
confirm the changes and close the window. (To return the window 
to its previous settings, click on the [Cancel] button.)
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Checking the Battery and Backlight
You can use PanaView to check on the PT878 battery status and 
backlight settings. To check on the battery from PanaView:

1. From the “New Meter Browser” option, click on the desired 
communications port and meter.

2. From the network tree, double-click on “Battery/Backlight.” 
The “Battery/Backlight Status” window appears, as shown in 
Figure 35 below.

Figure 35:  Battery/Backlight Status

3. The window shows the presence (or absence) of a battery, 
along with its power source, voltage, charge time and 
remaining time to run. 

4. The window also shows if the backlight is on and how long 
the backlight timeout is. Use the numeric keys to enter a 
backlight interval in minutes from 0 to 960 (16 hours) in the 
text box. If you enter 0 (zero) the backlight will turn off.

Click on [Apply] to apply the settings immediately, and on [OK] 
to confirm the settings and close the window. To return the 
window to its previous settings, click on the [Cancel] button.
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Changing Displayed Measurement 
Parameters and Units
PanaView enables you to actually change the measurements on 
the PT878 display. For example, through the PC, you can switch a 
window from its original programming of measuring flow 
velocity in m/sec to new programming of measuring Delta T in 
n/sec — or close the window entirely. 

To Open the Meter Display Window:

1. From the “File” menu, click on the “New Meter Browser” 
option. 

2. From the network tree, click on the desired communications 
port (COM 1, etc.) and meter.

3. From the expanded tree, double-click on the “Display” 
option. The “views” (windows) on the right show the data 
sources (velocity, volumetric, diagnostics, etc.) and display 
units that the PT878 is currently displaying. Figure 36 on the 
next page shows a typical “Display” option window for a 
PT878. Each individual view shows the mode and unit 
measured in the corresponding view on the PT878 display. 

Note: While each view shows the parameter and units measured, 
you must click on the “Text Display” option from the 
“Output” menu, or view the meter screen, to see the actual 
measurements at any given time.
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Changing Displayed Measurement 
Parameters and Units (cont.)

Figure 36:  The Meter Display Window for a PT878

1. To change a particular view, click on it. The selected view 
turns red.

2. Click on the PT878 on the network tree to the left of the 
programming window. A list of available channels appears. 
Click on the channel you wish to open.

3. The tree expands to show a list of available data sources. 

a. Click on the desired source, and the tree expands further to 
show a list of available units. 

b. Double-click on the unit, and the meter reassigns the 
selected view, on the meter and in the “Meter Display” 
window. 

c. To select from a numeric display or a line or bar display on 
the PT878, pull down the drop-down menu at the top of 
each view, and click on the desired display type.

d. To close a display window or open an additional view, 
click on the radio button with the desired number of views 
below the display windows.
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Changing Displayed Measurement 
Parameters and Units (cont.)
Figure 37 below shows a typical change on the PC screen from a 
numeric measurement of velocity in milliseconds to a 
measurement of Delta T in nanoseconds.

Figure 37:  Matrix Display After Programming
4. Click [Apply] to apply the change immediately and continue 

programming, and [OK] to confirm the change and close the 
window. To return the window to its previous settings, click 
on the [Cancel] button instead of the [OK] button.
PanaView for the PT878 49



July 2003
Setting PanaView Measurement Units
For the PT878, PanaView offers users the option of choosing 
either metric or English units as global measurement units for 
PanaView display. From the “View” menu (discussed in Chapter 
3 of the PanaView User’s Manual), click on the “Preferences” 
option, and then on the “Units” tab. The screen appears similar to 
Figure 38 below.

Figure 38:  The Units Tab in the Preferences Option

Click on the radio button with the desired units. Then click on the 
[Apply] button and then the [OK] button to accept any changes and 
close the “Preferences” box. To abort the process, click the 
[Cancel] button instead.
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